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Chapter 1. Contacting IBM Unica technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM® Unica technical support. Use the information in this section to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
Unica administrator for information.

Information you should gather

Before you contact IBM Unica technical support, you should gather the following
information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System Information" below.

System information

When you call IBM Unica technical support, you might be asked to provide
information about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
Unica applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by
viewing the version.txt file located under each application’s installation directory.

Contact information for IBM Unica technical support

For ways to contact IBM Unica technical support, see the IBM Unica Product
Technical Support website: (http://www.unica.com/about/product-technical-
support.htm).
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Chapter 2. About IBM Unica Detect version 8.5.0

This section describes the new features and changes introduced in the 8.x versions
of Detect, and changes in support for third-party software in version 8.5.0.
v “New features and changes in version 8.5.0”
v “New features and changes in version 8.2.0” on page 5
v “New features and changes in version 8.1.1” on page 7
v “New features and changes in version 8.1.0” on page 7
v “System requirements and compatibility” on page 9

New features and changes in version 8.5.0
This section describes the new features and changes introduced in the 8.5.0 version
of Detect.

Support added for double byte characters

Support for double byte characters is added in the 8.5.0 release of Detect. A
prerequisite is a Detect database that also supports the desired characters.

Broadly, this support consists of the following.
v Detect can now accept input files containing double byte characters, manipulate

those double byte characters in containers and comparisons, and generate
double byte characters in the outcome table.

v You can use double byte characters when you log in to Detect, when you name
most Detect objects, and when you configure components.

v Utilities now support double byte characters for user input such as user name,
password, and paths to feed files, and in the feed files themselves.

There are some exceptions to this support, as follows.
v Entity codes use only lower case letters of the English alphabet. If you use an

invalid character, this rule is displayed in the validation message in the user
interface.

v Vendor and workspace codes must use only upper case letters of the English
alphabet. If you use an invalid character, this rule is displayed in the validation
message in the user interface.

v In component editors, all numbers that you enter as a constant must be in U.S.
format. You must use a period (.), not a comma (,) to delimit decimals.

Adding this support has affected several areas of the Detect application; these
changes are described in more detail in the remainder of this section.

File encoding and date and currency formats are specified in the
Data Source editor

The Data Source editor allows you to set the file encoding and the format of dates
and currency for profile and transaction feed files. Note that your feed file
encoding and the date format and currency format of the feed data must match
what is specified in the Data Source editor.
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New configuration property controls sorting in feed files

There is a new sort order property, Feed file collation, on the General tab in the
Configuration Utility's pop-up window. If your feed files have a different sort
order from the collation set in your Detect database, you should set this property
to reflect the expected sort order in your feed files.

Note that, for Event Enabled Time Queue (EETQ) profile feed files, this setting is
applied only when you set the Inactivity Feed Path property in the Configuration
Utility. This property is located in the Processing Options section on the Advanced
Configuration tab in the Configuration pop-up window.

Also note that you must now save EETQ files in UTF-8 format (previously they
could be in ASNI format). Ensure that the program you use to edit and save these
files is capable of saving in UTF-8 format.

New configuration property specifies encoding for some files

There is a new property, Default Input File Encoding, on the Advanced
Configuration tab in the Configuration Utility's pop-up window. This property sets
the encoding for the following.
v State snapshot reports
v The input file for the Presentation Layer Manager
v Ramp-up feed files
v DebugIds.txt file for the engine
v uppressedRules.txt for the engine

Note that file encoding for profile and transaction feed files is specified in the Data
Source editor.

Scope of the Locale Identifier property is clarified in the
documentation

The documentation now clarifies the scope of the Locale Identifier property in the
Configuration Utility.

The Locale Identifier property sets the date format for the following.
v Reports
v Inactivity target date of Engine run
v Constants in Simple or Qualifier editors
v Outcome messages
v Outcome Management Tool parsing of dates from outcome tables
v Timestamps in Rampup feeds

The Locale Identifier property is located in the Locale section on the Advanced
Configuration tab in the Configuration pop-up window.

UTF-8 format is now used for Detect files

Files that are delivered with Detect and that Detect creates during operation are
now saved in UTF-8 format. These include SQL scripts, log files, error files, and
state snapshot files. Ensure that the program you use to open and edit these files
can handle UTF-8 format.
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New upgrade steps are required

The following upgrade steps are required after upgrade
v When you upgrade to Detect 8.5.0 from an earlier version, you must re-enter

and save all the passwords for user accounts and for the database access
accounts. You do this on the System Connections and User Connections tab in
the Configuration pop-up of the Configuration Utility. This is required because
the encryption algorithm has changed to support multi-byte characters.

v If your installation uses dates in non-ISO format, you must edit all of your data
sources to re-set the File date format field, because the date format for data
sources is new in version 8.5.0, and the upgrade sets the date format for data
sources to ISO by default.

License key is no longer required

When you perform a new installation or upgrade of Detect, you no longer have to
enter a license key in the installer. The license is now delivered as a set of text files
in the supported languages.

Trigger component names can be longer

Trigger component names can now be 85 characters long, increased from the
previous limit of 50 characters.

Input validation has changed

For enhanced security, validation on text entered by users in the Detect web
interface has been tightened. This will not cause errors in existing trigger systems,
but when you edit an object created in an earlier version of Detect, a validation
message may appear and you may have to change an existing string to pass
validation.

New features and changes in version 8.2.0
This section describes the new features and changes introduced in the 8.2.0 version
of Detect.

Role-based permissions and web user management

Starting with the 8.2.0 release, Unica Detect provides roles and permissions to
control users' ability to view or modify Detect resources. You administer Detect
users and roles on the User and User Roles & Permissions pages. To access these
pages, you must log in with a Detect account that has appropriate permissions. By
default, the pre-defined system account has this access, as does any user you
create and assign to the User Administration role. This system account replaces the
host_admin account used in previous version.

As in previous versions, you still set password policies through the Configuration
Utility.

Audit trail

In the Detect web application, two new pages, User Login Activities and User
Audit Trail, track user login activities and changes to user accounts. These pages
are visible only to users with appropriate permissions.
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Always on mode

Detect can be operated in an always-on mode. This means that once started,
multiple runs can be executed without having to incur the repeated cost of start-up
and shut-down. In this mode, Detect takes input from files and writes its outcome
to the outcome table. A command line interface allows you to communicate
commands (initialize, run, stop, and shut down) to the running application.

Security fixes

The following security issues have been fixed or addressed.
v Removed vulnerability of all APS.NET pages to Cross-Site Request Forgery

(CSRF)
v Encrypted view state for ASP.NET pages
v Re-wrote Label Manager and several other pages to remove security

vulnerabilities

New Label Manager

The Label Manager has been rewritten to enhance usability, performance, and
security.

Time constants

In math and qualifier expressions, new time constants allow you to specify time
spans that account exactly for monthly boundaries. For example:
v Beginning of 1 month ago
v Beginning of 12 months ago
v Beginning of next month

With these new constants you can define new time intervals, such as:
v The last three calendar months
v The three calendar months that started 6 months ago
v The last day of this month
v The last day of two-months ago

Command line interface for the ESO

The Entity State Optimizer (ESO), used for cleaning state history, can now be run
from the command line.

Graphic interface for Outcome Manager and Ramp Up

You can now run the Outcome Manager and Ramp Up from the Engine Manager:

Ability to modify data type for data source fields is restored

The ability to modify the data type for data source fields was removed in a recent
release, and is restored in this release.

Note the following:
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v If you modify the data type of a data source field, you should use caution. Logic
in any trigger that uses this data type may have dependencies on the original
data type and you must manually adjust these dependencies for the new data
type.

v You can change the data type of the field only when no state history is
accumulated for any of the triggers that refer to the changed data source.
(ENH09234)

FLI run-time control

You can now control the firing of Forward Looking Inactivity (FLI) components on
a run-by-run basis. You can configure a run so that it executes only a subset of the
FLIs in its workspace.

This enhancement is intended for a multi-environment configuration running
against the same workspace. Each environment can execute its own subset of the
FLIs in the workspace.

New features and changes in version 8.1.1
This section describes the new features and changes introduced in the 8.1.1 version
of Detect.

Support added for multiple environments

You can configure multiple Detect installations to run simultaneously while
accessing the same entity state data. To do this, you define multiple Detect
environments. Environments allow multiple runs to process transactions
simultaneously on different workspaces or, for when Detect system tables are in
SQL Server, even on the same workspaces.

See the Unica Detect Installation Guide for more information on multiple
environments.

New features and changes in version 8.1.0
This section describes the new features and changes introduced in the 8.1.0 version
of Detect.

New Component Graph feature added

Starting with Unica Detect version 8.1.0, in every workspace, you can view and
work with trigger systems in graph form. The graph clearly indicates the event
flow and the relationships among the components. The graph provides one of the
two ways you can access the Component Editor to build trigger systems (the
component list is the other way).

Detect automatically generates a graph of the workspace. The generated graph
hides clutter and lays out all of the components and component relationships in
the trigger systems. Version 8.1.0 7 New features and changes in version 8.1.0

You can optionally rearrange and simplify the graph and then save the modified
graph as a custom view. Detect updates the generated view and all custom views
when you make changes to trigger systems in a workspace.
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See the Unica Detect 8.1.0 User’s Guide for more information about the component
graph.

Workflow changes

The Workspace List has been enhanced to be the focal point for navigating through
the application and the launching point for the Workspace Editor. The Workspace
Editor has been added as the launching point for the component graph and the
existing component list.

User interface redesign

The Unica Detect user interface has been redesigned to conform to the Unica
Marketing look and feel.

Outcome Management Tool enhanced

The following enhancements have been added to the Outcome Management Tool
(OMT) to enable more flexible outcome administration.
v The OMT now incrementally processes outcomes for each new run, even though

the outcome table contains rows for a run that has already been processed.
v Trigger Exclusions in the OMT allow you to mark select triggers as excluded

from OMT processing. When the OMT is run, it by-passes triggers that you have
excluded.

Pattern Expression deprecated

In Unica Detect 8.1.0, the Pattern Expression component editor is no longer
available for adding new Pattern Expression components. The same logic can be
added to workspaces using other components. Customers using existing Pattern
Expression components can still use them. However, if a change is required in any
of these existing Pattern Expressions, Unica recommends that you engage Unica
Consulting Services to achieve the same logic using different methods.

State history data type changed

To enable easier administration in Oracle, the data field in the State History table
has been changed from the LONG RAW data type to the BLOB data type.

Unica documentation is now hosted

In Unica Marketing, online help and PDF files are no longer installed with the
products. Instead, documentation for Unica products resides on a remote server
hosted by Unica. When you click one of the help links in a Unica Marketing
product, you access help content from the Unica hosted server over the internet.

You can access Unica documentation by clicking Help in the Unica Marketing user
interface:
v Help for this page—Click this link to access HTML content specific to the

product page on which you are working. This context help is new in Unica
Detect 8.1.0.

v Product documentation—Click this link to access an index to the PDF
documentation for the product with which you are currently working.

v All Unica documentation—Click this link to access an index to the PDF
documentation available for all Unica products.
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Note: You can also access PDF manuals for all Unica products using Customer
Central (https://customercentral.unica.com). If you do not have internet
connectivity at your site, you can download and install online documentation
locally within your network. However, keep in mind that the latest documentation
will always appear on the hosted documentation server. If you choose to install
locally, you will not receive periodic updates. Contact Unica Technical Support if
you need to download a documentation package.

System requirements and compatibility

This section provides information on where to find system requirement and
compatibility information for 8.x versions of of IBM Unica Detect, and highlights
changes in support for third-party software in version 8.5.0.

Where to find system requirement and compatibility information

For a list of IBM product versions compatible with this product, refer to the IBM
Unica Product Compatibility Matrix and any other product compatibility documents
posted under Documentation on the IBM Unica Customer Central web site
(https://customers.unica.com).

For a list of third-party requirements for this product, refer to the Recommended
Software Environments and Minimum System Requirements posted for Detect on the
IBM Unica Customer Central web site (https://customers.unica.com).

Key third-party software support changes in Detect version 8.5.0

Detect version 8.5.0 has ended support for version 9 of the Oracle database.

Fixed defects

This section describes the fixed defects in the 8.5.0 version of Detect.

ENH08391 Performance was slow when Is Member Of was used on a component
other than a Simple component. A code change has fixed the
performance issue.

DEF040936,
INC37970

When you used the Validate Feed Folder option in the Feed Validator,
an error occurred. This has been fixed.

DEF040980 Runsets containing some trigger systems supplied with the Credit Card
EBM and Retail Banking EBM libraries could not be published because
the rule name exceeded the length limit. The limit has been increased.
However, name length is still limited. When you clone a trigger
system, you should not use more than 95 characters. When you name a
new component, do not use more than 86 characters. Also note that in
many areas of the user interface, only the first 50 characters are
displayed.

DEF041125,
DEF026818

Saving a logic type Pattern Expression caused an error. This has been
fixed.

DEF042152,
INC38921

After upgrade, you could not execute the Outcome Management Tool
(OMT) from the command prompt. This has been fixed.

DEF049004 If you cloned the PUB or XPUB workspace and gave a cloned
component a name that was more than 44 characters long, you saw an
error message. Now you receive a warning that informs you of the
length limitation of 44 characters.
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DEF050778,
INC47431

The Outcome Management Tool (OMT) generated a timeout error in
SQL server and was not able to populate the outcome tables and flat
files. This was fixed by increasing the command timeout on selected
queries.

DEF051656 When you removed a component from a workspace that had one or
more custom views, Detect did not automatically remove it from the
source workspace; you had to perform this step manually. This has
been fixed.

DEF052972,
INC51766

In the Outcome Management Tool (OMT), the precision was not set for
money fields when the Detect database was SQL Server. This has been
fixed by adding configurable precision for SQL Server.

DEF053152,
INC52310

The Library Manager was not recognizing the IsMemberOf operation
in an expression. This caused the Select not to appear in the hierarchy
view of the component manager. This has been fixed.

DEF056634 The Feeder trace log grew fast during a large production run. This has
been fixed.

DEF056684,
INC63030,
INC56888

Timeout errors occurred during some operations. This issue has been
fixed.

DEF057427,
INC57639

When multiple engines were used, not all outcome messages were
processed by the OMT. This has been fixed.

DEF057908,
INC61906

A unique constraint violation error sometimes occurred on the visitor
history table with a multi-cluster environment while using no profile.
This has been fixed.

Known issues

This section describes the known issues in the 8.5.0 version of Detect.

Entity State
Optimizer
dates are not
localized

In the Entity State Optimizer (ESO), the date formats
used on the command line must follow the ISO-8601
date format (YYYY-MM-DD), regardless of the locale set
in the Locale Identifier property.

Known limitations

This section describes the known limitations in the 8.5.0 version of Detect.

Library
Manager does
not fully
support Import
of Runsets

Runsets with circular or deep reference hierarchies may
not import correctly.

Reports may
display
confusing
results

Repeatedly running a report for the same workspace
using the same transaction feed file date may create
confusing results in some reports. You may see more
firings than you anticipate, and the number may increase
if you run the report again. This limitation is most likely
to appear during testing, and not in production, because
during testing you are more likely to repeatedly run a
report for the same cycle date.
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Large Export
Trigger System
to Visio reports
do not
automatically
print on
multiple pages

Large Export Trigger System to Visio reports do not
automatically print on multiple pages. Use this
workaround if you have an Export Trigger System to
Visio report that does not fit on one page. In Visio, do
the following:

v Go to File > Page Setup and select Page Size.

v Select Size to fit drawing contents.

v Select OK.

The report will now print across multiple pages. You can
see the multiple pages by using File > Print Preview.

Some
connectors on
Export Trigger
System to Visio
reports do not
automatically
connect to their
corresponding
shapes

If a connector on an Export Trigger System to Visio
report does not automatically connect to its associated
shape, move the shape and the connector will attach to
it.

Some reports
do not support
runsets

The Response Rate Totals report and Response Rate
Financials report do not support runsets. You can choose
workspaces.

Lookup table
schema and
content are not
imported or
exported

The ExportManager and ImportManager tools export
and import the data source definition of the lookup
table, but not its content. This is a known limitation
within the Library Management tools.

Issue with
import of
lookup tables

Lookup tables with external connections will be
imported without a connection set, if the external
connection does not exist in the destination.
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Trigger system
entity type
validation
cannot always
verify the
entity type
used

During initialization (compilation), Detect cannot detect
all cases in which a trigger system is invalid.

Although during initialization Detect validates that the
entity types of the trigger system and the feed file are
compatible (and skips the trigger system if they are not),
there is a rare and unlikely scenario in which the system
cannot fully determine that the entity type of the trigger
system is incompatible with the entity type of the feed
file. One case is when a branch is not clearly tied to an
entity type.

During initialization, the system may not be able to
determine the true entity type of an Action if the
components that reference it are neutral and do not draw
the entity type from components that reference them. A
component is neutral if it can be used by any entity type.

You should put a component on the action that pins it to
the proper entity type. For example, if the Action
contained a Trend condition or if the Action contained a
no-op condition that checked that the Account Number
was greater than 0, then the Action would be associated
with the Account entity type, and the ATX to Action path
would not execute during processing of the customer
feed files. Note that in this case, if trace logging were
turned on, then a trace message would be logged that
this execution path was being passed over.

When you try
to view a large
hierarchy in
the component
manager you
may see an
error

When you try to view a page with many components
(such as a large workspace with circular references) you
may see the following error.

Response object error ‘ASP 0251 : 800004005’

Response Buffer Limit Exceeded

/insights/rulemanager/ResultsPane.asp, line 0

Execution of the ASP page caused the Response Buffer
to exceed its configured limit.

If you see this error, use these steps to change the
MetaBase.xml file to increase ASP buffer limit.

Note: Change the buffer limit only if you see this error
message.

1. Stop IIS.

2. Make a backup copy of the Windows\System32\
inetsrv\MetaBase.xml file.

3. Open MetaBase.xml in a text editor.

4. Search for AspBufferingLimit and change its value.
The system default size is 4MB. Use trial and error to
find the limit that works for you.

5. Save MetaBase.xml and overwrite the existing version
of it.

6. Restart IIS.
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A trigger
control on a
container
manipulator
does not
increment if
the container
manipulator
has no down
stream rules
attached to it

DEF018718 A trigger control on a container manipulator does not
increment if the container manipulator is at the end of
the chain and has no down stream rules attached to it.
For example, if the container manipulator only inserts a
record, and does not generate output or fire a rule, then
it cannot increment a trigger control.

Numbers at
the beginning
of type
descriptor
names cause
problems

DEF019444 Due to the way Microsoft parses XML, you should not
use numbers at the beginning of type descriptor names
within the system. When the names are encoded in XML,
any initial number is converted to a code and is no
longer recognized by Detect. For example, if a field is
called “1stActvtyDate”, the number “1” in the
“1stActvtyDate” becomes encoded in the XML
description of the type descriptor as
“_0031_stActvtyDate”. But when a container manipulator
is created in the user interface, Detect looks for
“1stActvtyDate” which cannot be found in the database
and an error results.

To work around this issue, avoid using numbers at the
beginning of type descriptor names. In this example, you
should instead use the field name “FirstActvtyDate”.

Math
component
requires an
operator

DEF025657 You cannot define a Math component that does not have
an operator. However, in certain cases you may want to
define a Math component with only one field, such as to
define a time constant. As a workaround, you can add 0
or multiply by 1.

For Oracle, the
Outcome
Management
Tool does not
return an error
if bulk loading
fails

DEF025678 When the Outcome Management Tool (OMT) is
populating an OMT outcome table, it uses a bulk load
import process. If there is a bulk load failure on SQL
Server, SQL Server returns an error message that
indicates that the run failed.

However, Oracle reports the failure to a .bad file. The
OMT does not capture the error. To confirm the status of
the run for a table, look at the Application\OMT directory
under your Detect installation directory.

For Oracle, that directory should always contain
Table_alias.dat and Table_alias .log files for each
OMT table processed. If there is an error, there will also
be a Table_alias .bad file. For SQL Server, there should
be a Table_alias.dat file.

Components
may overlap in
Export Trigger
System to Visio
report

DEF027817 When you generate an Export Trigger System to Visio
report, you may find that some components overlap. You
can rearrange the components.

Issue with
saving an
entity type

DEF028390 When you add an entity type through the Data Sources
manager, you may have to click Save twice before the
window closes. The entity type is saved the first time
you click Save, but the window may not close until you
click Save again.
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In the
Presentation
manager,
misleading
errors may
appear if you
create a list
with a name
that is already
in use

DEF028514 If you attempt to create a list in the Presentation
manager that has a list name that is already in use, you
will see a misleading error. If you select Create with
Content and browse to insert a file, the error says you
were creating an empty list. The misleading error occurs
because the validation for duplicate names clears the
path.

Publishing
very large
runsets may
take a long
time

DEF028879 Very large runsets, especially those that contain
Backwards Looking Inactivity components (BLIs), may
take a significant amount of time to run. Let it run and
do not close the application or interrupt it in any way;
instead, allow it to finish.

The Data
Sources
manager
allows you to
create two
profile feed file
data sources
with the same
entity

DEF029983 When using the Data Sources manager, you can create
two profile feed file data sources with the same entity.
However, the system should validate for the unique
combination of profile feed file and entity.

If you store
outcome in a
separate
database from
the rest of the
Detect data,
both databases
must be from
the same
database
provider

DEF041111,
DEF041118,
DEF041119

If you choose to store outcome data in a separate
database from the rest of the Detect data, both databases
must be from the same database provider.

When using
First or Last on
a container or
select function,
either ensure
there is a
timestamp on
the
transactions or
compress the
data by day

DEF043484 If the transactions are only date stamped (no time
component) the engine has no way today of telling the
transaction order among transactions with the same date.
If there are multiple items with the same date stamp, the
engine may return any one of them as the First or Last
item, and may not return the actual first or last item that
was added to the container.

If you want the First or Last to unambiguously return
one item, you must ensure that the transactions have
time stamps. An alternative strategy would be to
compress the data by day. Compressing the data by day
will return a single first or last item because there will be
at most one record for every date, but note that you lose
the granularity of the individual transactions.
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Drop table in
OMT drops
table even
when it issued
by another
workspace

DEF049492 When you copy a workspace and then use the Outcome
Management Tool to drop an outcome table in the copied
workspace, it is dropped even though it is being used by
the original workspace.

The workaround is to change the trigger alias in the new
workspace using the Outcome Management Tool. The
new workspace then points to different outcome tables
than the original workspace, and dropping a table does
not affect any other workspace.

If a component
name has
diacritic
characters, its
summary is
not displayed
on the
component list

DEF059705 If a component name has diacritic characters, the
component's summary on the View Summary page is not
displayed when you click the View Summary icon in the
component list. Avoid using diacritic characters in
component names.

Trace utility
does not work
when
numerical
values are too
large

INC31673,
DEF32837

The engine cannot transform the results of a Select into a
string to report in the trace log if the results of a select is
too large. The error occurs because the numerical value
has become too large for the variable that is holding it.
That variable has a limit of 32,767, which means the
results of the Select that causes the error is very large.

TSM/System
log is not
automatically
recreated after
the log
directory is
removed

INC31724,
DEF32892

If you remove the logs directory under the vendor, on
the next run the TSM/System directory is not recreated
although all the other directories are. Without the folder,
the log is absent. Do not delete the directory. As a work
around, if you delete the logs directory you must
manually recreate this folder in order for the log file to
be written to it.

Entity ID
cannot be
defined as a
number

REQ20818,
ENH6368

You cannot define the entity ID as a number. The feeder
sorts them as a string and expects them to appear in the
feed in alphanumeric order. The feeds must be sorted in
alphanumeric order.

Response
Manager
cannot process
a response
with if the Unit
is set to Infinite

DEF016181 You can define a response with the Unit field set to
Infinite. However, do not use that option. If you do, the
Response Manager (ResponseManager.exe) will fail to
process it.

The Individual
Trigger
Analysis report
may produce
No Data
Found

DEF041196 If you create and publish a runset of multiple
workspaces, then copy the Pub workspace to a new
workspace, then run data through the new workspace,
the Individual Trigger Analysis report may produce a No
Data Found error.
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When using a
lookup table,
ensure that the
data type for
the lookup
table matches
the data type
of the data
source

DEF042089 If you are using a lookup table, ensure that the data type
for the lookup table matches the data type of the data
source. In rare cases, if you are using NET Framework
2.0 SP1, a Select statement may fail with the error
message: "Min (389) must be less than or equal to max
(-1) in a Range object" where X is a number greater than
-1.

If you are using an earlier version of NET Framework
you will not see the error message but you should still
ensure that the data types match.

The Back
Engine fails on
Is Member Of
if the "Is
Member Of"
operand is not
used

DEF042142 In prior releases you could create an Is Member Of
qualifier using a blank function rather using the Is
Member Of operand that was added in version 7.1.0.
That method still works on a Simple event component,
which runs on the front engine, but does not work for
other components, which run on the Back Engine. The Is
Member Of operand must be used, as described in the
IBM Unica Detect User's Guide.

Compression
errors occur in
Container
components

DEF048838 Compression does not always work as expected in the
Container component. For example, when the Period
Start = 0, Time Unit = Day, and Period Length = 2,
Detect should output all the matching records falling
under two days. Instead, it compresses the records on
daily basis, as though the configuration were Period Start
= 0, Time Unit = Day, and Period Length = 1.

OMT does not
provide a
validation
message when
you try to
improperly
configure
outcome tables
in the OMT

DEF049851 When an Action component points to more than one
outcome table, and you edit only one table to exclude it,
the excluded table is still displayed as included in the
OMT. Detect should display a helpful error message.

Dependent
components
are ungrouped
when the
parent is
deleted

DEF051786 When you delete a component from a group that has a
dependent component, the dependent component is
displayed outside of the group in the custom view. If
desired, you can move the component back into the
group manually.

OMT fails to
save if As
scalar property
is selected

DEF053039 When you attempt to save changes in the Outcome
Management Tool (OMT), the changes are not saved if
the As scalar property is selected.

On Oracle,
ESO error is
not logged for
incorrect file

DEF05366 On Oracle, when you use the Entity State Optimiser to
clean state data, If you specify an incorrect file as the
entity source, the error is not logged.

Component
graph
connectors are
sometimes
incorrect

DEF054110 Spike, exceeded standard deviation, and qualifier
connectors are displayed with same color on the
component graph, and spike connectors are hidden when
you click the Hide/Show Qualifier connectors button.
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OMT does not
populate data
from a second
outcome table

DEF054538 The Outcome Management Tool (OMT) populates data
only from the default outcome table.

Failed login
attempts are
sometimes
logged
incorrectly

DEF054852 A failed login attempt by a user with no roles assigned is
recorded as successful on the User Login Activities page.

A container at
the top of a
hierarchy
cannot be
copied to a
different
workspace

DEF18639 A container that is at the top of the hierarchy cannot be
copied to a different workspace because it has a
dependency on the container manipulator. To work
around this issue, create a dummy container manipulator
for the container, copy the container and container
manipulator to the new workspace, then delete the
container manipulator in the new workspace.

Trigger control
does not
evaluate on a
partial match

DEF18678 A user can create a simple rule that can be only partially
matched in the (stateless) front engine. The part that
cannot be matched is sent to the (stultify) back engine. If
a trigger control is put on this rule, it is not checked as it
should be and will fire every time it matches. As a work
around, do not put a trigger control on a simple rule. Put
it on something down stream.

Selecting all
components in
a workspace
may cause the
interface to
time out

DEF20747 When you move or copy a workspace with a large
hierarchy, using the checkbox that selects all components
in the workspace causes the interface to hang and time
out.

Type descriptor
fields are not
updated
appropriately if
you do not
click Add Field

DEF22485 If you change a value in an existing type descriptor and
click Save Definition without clicking Add Field first,
the change is not saved. To work around this issue, be
sure to click Add Field when making a change to a type
descriptor field.

Detect does not
require
confirmation
when
removing type
descriptor
fields

DEF22667 Detect does not display a confirmation message,
allowing you to cancel when you choose to delete a type
descriptor field. If you edit a type descriptor, select a
field, and click Remove Field, Detect deletes the field
immediately; you cannot cancel the deletion or revert
back to the original value.

Some reports
always
generate a
graph

DEF25268 Some reports always generate a graph, even if you have
not selected the Show Graph option.

Workspaces
with large
trigger systems
may load
slowly

DEF27667 When you use the Components manager to open a
workspace with very large trigger systems, you may
experience a wait time of a minute or more.
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Paging through
the list of data
sources in the
Data Sources
manager may
cause an error

DEF28554 If you have multiple pages of data sources listed in the
Data Sources editor, you may see an error message if you
open one of the data sources in the Edit mode, then page
through the list while the data source is still in edit
mode.

Boolean data
type is not
processed
correctly by the
front engine

DEF28638 The boolean data type is not processed correctly by the
front engine. Do not use the boolean data type in a
simple event such as a validation parameter. As a
workaround, you can use other data types to match the
value. For example, use a string to pass in True or False.

Before
publishing a
runset with a
backward
looking
inactivity (BLI),
there is no
option to
change the
start date

DEF30471 Before you publish a runset with a backward looking
inactivity (BLI), there is no dialog box to allow you to
change the start date.

If the Outcome
schema is not
in the Detect
database, the
install scripts
do not
establish the
connection

DEF30746 If the Outcome schema is in a database other than the
Detect database, the current install scripts do not
establish the correct connection for the outcome schema
in the %Vendor%_Connections table. As a workaround,
open the Configuration Utility and configure the
outcome connection to point to the Outcome database.

An error
occurs when
saving a
component
when labels are
assigned

DEF51706 When you open any workspace in the workspace editor,
then add a label using the Label Manager, and then use
that label item in a component, you cannot access that
workspace’s graph. If you create all labels before
accessing the workspace editor, the problem does not
occur. If the problem does occur, you can resolve it by
restarting the Detect IIS service.

Cannot publish
a runset with
long
component
names

DEF51802 If a runset contains one or more components with names
longer than 50 characters, publication fails.

Back to last
workspace link
on Responses
page is
sometimes
broken

DEF51819 If you access a workspace from the Responses page, and
response data exists, if you leave the Responses page to
view the data and then click the Back to Last workspace
link on the Responses page, an error occurs.
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When you
update a
container
manipulator, a
refresh
problem may
occur

INC17131,
DEF19206

When you edit a container manipulator to place a
different field into the container, the DO section defaults
to the first action on the right side of the window. The
Component manager edit mode does not properly
refresh information on the left side with information that
is displayed on the right; this refresh problem causes a
data conflict that ultimately causes an error when the
container manipulator is saved.

To work around this issue, select something other than
the data source in the DO section, then go back to the
data source and choose the correct field.

Action Volume
Trend report
may display
inconsistent
results when
new Actions
are added to
the workspace
midway
throughout the
period

INC17757,
DEF19703

The Action Volume Trend report may display
inconsistent results when new Actions are added to the
workspace mid-way throughout the period. To work
around this issue, open a new report, set the dates, and
view the results for that cycle time.

When you
clone
workspaces,
the “search
replace”
feature does
not validate for
the name
length

INC18175,
DEF20102

When you clone a workspace, the "search replace'”
feature does not enforce the name length limit and
allows identifier strings to be longer than 36 characters.
The long names cause an error when the workspace
cannot be published. To work around this issue, do not
increase the length of the string you are replacing.

Engine Trace
Utility fails on
transactions
skipped in
recovery

INC18873,
DEF20762

The Engine Trace Utility cannot read logs from a
recovery run. The Engine Trace Utility cannot properly
handle entries for previously processed transactions.
Instead, you can examine the log, but without the Engine
Trace Utility.

Action Volume
Trend
selections
change as
selected dates
change

INC19467,
DEF02120

When multiple triggers are fired in a selected date range,
the first time you run the Action Volume Trend report it
displays firing counts for all triggers (or the first ten
triggers if they are more ten). The Action drop down
highlights fewer triggers than are displayed in the
results. However, if you select the number of triggers
you want to display and run the report again, they all
display.

Feed Validator
does not
support some
locales

INC22615,
DEF17766

The Feed Validator does not support these locales: UK
and Australia.

Feeder fails if
processing two
entities with
different cycle
times

INC36608,
DEF32472

If you run multiple entities at the same time, the feed
folder must contain entity feed files with matching
timestamps for each entity. Likewise, if you have
multiple feed files for any one entity, you must include
matching feed files, with matching time stamps, for each
entity. As a workaround, you can run each entity
separately.

Chapter 2. About IBM Unica Detect version 8.5.0 19



During import,
the Library
Manager may
lose the
hierarchical
relationship
between a
select
component and
a qualifier
component

DEF30598 During import, the Library Manager may lose the
hierarchical relationship between a select component and
a qualifier component. As a workaround, save the
qualifier that is referencing the select component, or copy
the workspace.

Unattended
installation
clears installer
properties files

DEF042448 When you run the IBM Unica Marketing installer in
unattended mode, the installer properties files are
deleted. IBM Unica Marketing recommends that you
make backup copies of all the .properties files under
the IBM Unica Marketing installation directory before
running the IBM Unica Marketing installer in unattended
mode for the first time, and restore them each time you
run the installer in unattended mode.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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